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About Primafact 6 

Primafact 6 takes case development to the next level. We have equipped Primafact  

for more efficient document review and case preparation. 

Starting with your Inbox, Primafact 6 adds tools to sort, filter, code and track your new materials, 

making it easier to review and instruct and preserve details for future review. Enhanced coding tools 

capture key case information, to automating the intensive task of memo building.   

Primafact 6 enhances efficiency at every stage of review, connecting meaningful analysis to source 

materials for better preparation and case understanding throughout the life of the case. 

  

Video Overview 
Click here to view our 10-minute overview of the new features available in Primafact 6. 

We also offer a number of video tutorials on the individual features to help you get started. 

 

 

New in Primafact 6 
Primafact 6 includes a number of new features, as well as enhancements to features available in 

Primafact 5.  These include: 

 

More Powerful Templates 
 

Configure your Cases more efficiently than ever with more feature-rich Case 
Templates.  Case Templates now pack the coding standards and preferred 
views designed for your Case type. Open Cases with views & coding already 
built-in, or easily update existing cases to match new Coding standards and 
report-friendly views.  
 

Primafact Inbox This is a special user-level folder designed to facilitate document intake and 
review, with search, filter and messaging capability via the new Discussions 
feature. 
 

Review Workflows • New review workflow tools enable review tracking to more efficiently 
manage and monitor document review and associated activities.  

• Early Case Assignment enables documents to be associated with their 
assigned Case prior to filing. 
 

Document Discussions This new feature allows messages to be exchanged within user Inboxes, with 
real-time notification. 

 
Binder Enhancements Visual coding enhancements, search and filter tools directly within the 

binder, and enhanced previews make identifying materials in your binder 
more efficient than ever. 

https://www.primafact.com/whats_new_in_primafact_6_video_project_astrolabe
https://www.primafact.com/pf6/early-adopters


 

Working with Primafact 6  - New Feature User Guide  7 

 
Document Preview 
Enhancements 

More information available on the Document Preview, with new Tabs for 
convenient annotation review and document discussion within Binders and 
Inboxes. 

 
Easily build Chronologies, 
Outlines and Reports 

 

• Instantly assemble chronologies and outlines from Primafact into Word 
and Excel 

• Link back directly to Primafact source content  

• Export URL link to Word memos 
 
Annotation 
Enhancements 

 

• Chronology support with Event Date + Time tracking 

• 12 more annotation colours + custom labels for uniform coding 

• Dedicated favorability coding 

• Dedicated Text Excerpt field 

• Annotation Repeats, Templates & automation 

• Batch updating capability 

• Better annotation view and search on documents, previews and lists 
 
List View Enhancements 

 

• Control default views, create and access multiple alternate views that 
can be displayed in a single click 

• Pop-Out List feature enables list views to be displayed alongside other 
Primafact windows  

  
Copy Documents to 
Browsers 

Drag & Drop documents to Browsers and other locations outside Primafact  
more efficiently 

 
E-Briefs 

 
Assemble electronic briefs, including CaseLines filings, efficiently with 
highlighting, hyperlinks, Document Title Aliases, and PDF Publish tools. 
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Create and Update Cases With More Powerful Templates 

Primafact 6 makes applying unified Case Standards more efficient than ever with coding settings and 

views built right into the Template. 

 

 

 

 

Create New Cases  
When adding a new Case to Primafact, you will now see a new Create New Case dialog: 

 

Now you can enter your New Case name before it’s created, and select the Template you want to use 

for your Case using the dropdown beside the Select a template field. 

By default, all Template settings, including coding settings and views, will be included in your new Case.   

Optional: to selectively apply Template Settings click the Show More button and choose your settings. 

Click Create Case to save your new Case.   

Note: You can also copy the structure and settings of a selected Case, in addition to copying from 

Templates, by un-selecting the Case Templates Only checkbox.  This allows you to use any Primafact 

Case as the basis of your new Case. \ 

Updating Existing Cases to Match Template Settings 
If you are updating to Primafact 6 with an existing caseload, it’s easy to update existing cases to match 

your Templated Coding Standards and Case Views.  You can even apply coding settings from another 

Case using this tool. 

 

Watch the video here: Using Case Templates 

 

 

 

https://www.primafact.com/primafact-6-tutorial-using-case-templates
https://www.primafact.com/primafact-6-tutorial-using-case-templates
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Apply Settings from a Template to an Existing Case 
 

1. Start by opening a binder on the Case you want to update. 

2. Click the Geary on the far-right of your blue binder ribbon. 

 

3. Click Setup Case From Template from the dropdown menu. 

4. The Setup Case Window will open. 

5. Choose the template you wish to copy. 

 

6. Click the Chevron beside any areas you wish to copy. 

 

7. Select the Copy Case Template button for template options you wish to copy to your Case.  Select 

Keep Current to retain your Case’s current settings for that setting.  (By default that setting will 

make no changes to a selected setting unless you select Copy Case Template.) 

8. When you have completed your selections, click Update Case to update. 

9. To select specific areas to update, expand the Other Setup menu item using the blue chevron to 

expand.  
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Add Date of Loss to your Case 

Adding the Date of Loss to your Case Summary makes it easy to filter Events by Pre-DOL and Post-DOL 

using Primafact filter tools.  Also, the DOL is displayed on all Case Binders and Case Views, for 

convenient reference. 

To add the Date of Loss to your Case Summary: 

1. Navigate to any Binder in your Case 

 

2. Select Summary on the blue tab bar  

 

3. The Summary Screen will open. 

 

4. Click the Edit button to add the Date of Loss. 
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5. Enter the Date of Loss in the Date of Loss field 

 

 

6. Click Save to preserve your new setting. 

 

The Date of Loss will now appear at the top right of your Case views, and will be available for use in 

Date of Loss filters. 
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New Coding Capabilities 

Primafact 6 includes additional coding capabilities at the both the document level and for annotations. 

New Document-Level Coding 
You can now add team flags to documents to designate document-level attributes.  Team Flag Labels 

can be customized system-wide, or by Case. 

As an example, a document with a Red Flag could mean “Offer Attached.”  A document with a green flag 

could mean “Outbound Correspondence.”  Alternatively, you could use flags to designate attributes like 

“Served” or “Ready to File.”   

The flag makes it easy to identify content of a particular document, so you can filter for those attributes 

on a search.   

See Customizing Team Flags below for details on how to set up customized Team Flag Labels.  

 

Annotation Coding Enhancements 
Primafact 6 includes a number of coding enhancements designed to better track key Case Issues and 

dates, with the goal of making comprehensive reports and chronologies available for efficient Case 

preparation.  For details on updates to the Annotation Form, see Annotation Form Updates below. 
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Binder Enhancements 

 

Binder Search and Filter 
You can now complete full-text document searches directly from your Primafact Binders, making it 

easier than ever to locate specific information when reviewing from a Binder. You can combine filters 

with searches for very targeted document identification within your binders. 

Search Bar 
The search bar is located at the top of the Binder toolbar.   

 

By default, Primafact 6 is set to perform full-text searches, including document titles, page text, 

annotations and profile fields.  To perform a search, click on the search area and type your search query.  

Click the Enter key to perform your search.  To adjust search settings, see Changing the Search Filter 

Options, below. 

If your search bar is set to perform Full-Text searches, you can use wildcards (* and ? characters) to 

replace characters in your search. 

 

Changing the Search Filter Options 
The Binder search bar can be set to perform a Quick Search, which searches document titles,  or Full-

Text Search, which can include content in Titles, Page Text, Annotations and Profile Fields, depending on 

your selected settings.  

1. To adjust your settings, click the filter dropdown to the right of the search bar: 

 

  

2. Click Search Options. 

 

  

Watch the video here: Using Binder Viewing Enhancements 

 

 

 

https://www.primafact.com/primafact-6-tutorial-using-case-templates-0
https://www.primafact.com/primafact-6-tutorial-using-case-templates-0
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3. The Binder Text Filter Options dialog will open: 

 

4. Select the Quick Filter button to perform Quick Searches.  Select the Full Text Search Button to 

search for text content within your documents. 

5. Selecting or de-selecting the Titles, Page Text, Annotations, and Profile Fields checkboxes will 

adjust the scope of your Full-Text Search. 

6. Click OK to preserve your selection. 

 

Using Filters 
You can use filters on their own, or combine with text filtering for focused document identification.  You 

can also apply more than one filter at a time for more refined results.   

 

 

Filters are located on the binder toolbar to the right of the binder search bar.  Available filters are: 

 Key Document 

 Team Flags (Dropdown allows you to select multiple flag colors) 

 Annotation Colors (Dropdown allows you to select multiple annotation colors 

 Annotation Favorability (Choose Favorable, Adverse, or both using the dropdown) 

 Annotation Issue  

 Document Date (Allows you to specify document date or date range) 
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Reviewing Filters 
1. To review which filters have been applied, click the yellow Filters button: 

 

2. The Current Binder Filters window will open: 

 

3. Click OK or Cancel to close. You can also selectively clear filters using this window.  

 

Clearing Filters 
1. To clear an individual filter, click on the selected item to de-select.  For filter options with a 

dropdown, click the dropdown and select Clear Filter. 

You can also click the X on the Clear Filter button to clear all applied filters. 

Selectively Clear Filters 

1. To selectively clear filters, click on the yellow Filters button.  The Current Binder Filters window 

will open.  
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2. Select the filter you want to remove and click the red X button.   

3. Repeat as desired.   

4. When finished click OK. 

 

 

Document Preview Enhancements 

Document Preview Tabs 
We have updated the Preview area to display more 

information without needing to open the document. 

There are now four tabs: 

• Preview Tab – Displays selected document 

• Profile Tab – Displays associated document profile 

information 

• Annotation Tab – Displays document information 

on a searchable, filterable list 

• Links Tab – Shows hyperlinks added to a 

document, notes and link address 

• Discussion – Displays document discussion history 

• Information – shows additional document-level 

information, including document locations in 

Primafact, OCR status, review status and technical 

information. 

Each of the Preview, Profile, Annotation and Links Tabs 

display the document Title, Key Document coding, 

Reviewer and Team Flag information. You can 

name/rename the document, apply Key Document 

coding, apply Review status and apply Team Flags using any of these three tabs. 
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Document Viewing 

Open Document Enhancements 
It’s now easier to identify document context by quickly locating the document within its binder.  Simply 

click the Show in Binder button on the document toolbar to be taken to the document’s location in the 

binder view.  

 

If a document is copied to multiple locations, you can choose an alternate location by clicking the 

dropdown arrow beside the  Show in Binder button and selecting the desired binder location. 
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The Inbox  

Recognizing that document review often starts with the Inbox, we have created a dedicated Inbox 

feature with capabilities that include the ability to search and filter documents in your Inbox, set 

preferred views, and manage inbox discussions for quick and convenient team document 

communications. You can create your own subfolders to organize inbox materials as desired. 

You can access your Inbox by clicking on the My Inbox Icon at the top of the Shortcuts bar: 

  

 

Viewing your Inbox 

Main Inbox 
The top level of your Inbox (Main Inbox) is designed to show you anything new that has been added to 

your Inbox.   

You can decide if you want your Main Inbox to also show the contents of any subfolders, or just the 

contents of the Main Inbox folder.  By default, Primafact shows the contents of the selected folder only, 

meaning no content filed in subfolders will be shown.   

 

New Arrivals Indicator 
When new documents or messages arrive in your Inbox, your Inbox Icon will display the number of 

unread items appearing in your Inbox: 
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Note: If your shortcuts toolbar is hidden or disabled, your inbox notifications appear at the bottom-left 

corner of Primafact. 

 

 

 

 

Identifying Inbox Folders with New Items 
Individual folders with new items will also display a bolded title along 

with the number of new items:   

We recommend you set aside time to check your Inbox regularly for new arrivals. 

 

NOTE - You can mark items “Read” or “Unread” by right-clicking on the item and selecting Mark 

Read/Mark Unread. 

 

 

Refresh button 
We recommend you click your Refresh button from time-to-time to confirm you are viewing the most 

recent content in your Inbox.  
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Searching your Inbox 
You can search and filter content in your Inbox. As with the binders, you can set your Inbox to complete 

Full-Text Searches, or Quick Filter searches.   

For guidance on how to use the filters, see Using Filters in Binders, above. Note the available filters will 

be slightly different in the Inbox. 

 

 

Filtering Inbox Content 
You can filter your Inbox as needed in the moment, and even preserve those filters in saved Views for 

quick future access.   

Primafact 6 has two built-in filters: For Review and For Filing. When you are in your own Inbox, the For 

Review filter identifies content marked for your review, and not marked done.  The For Filing filter 

identifies documents marked for filing by you. 

 

 

Adding Documents to your Inbox 
Documents may be added to Primafact Inboxes the same way you add documents to any location in 

Primafact.  This includes Dragging & Dropping, and Scanning to the Inbox if you have a compatible 

scanning configuration.   

You can also right-click on any document in Primafact and click the menu option, then select the 

recipient(s) who will receive the document in their Inbox  

 

 

See Sending Documents to Other Users’ Inboxes below for guidance on sending documents to other 

users’ Inboxes. 
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Adjusting Your Inbox Settings: Setting Up Your Inbox  

Note: For instructions on refining your Intox List View, see Customizing List Views, below. 

Customizing your Tab Bar  
You can change the items on your Tab bar to provide quick access to the views that are most important 

to you.   

To customize your Tab Bar:  

1.   Click on the gear icon  at the far right of the blue Tab bar: 

 

2. The Tab Bar Options window will open. 

 

3. Select the Views you wish to add or remove from the Tab bar using the  arrows. 

4. Position the View order using the  arrows.  

5. Click OK to save your changes. 

 

Change Inbox View – Folder Content  
Inbox View settings can be set at the User Level to allow you to see your preferred fields and formatting 

when you review your Inbox.  Changes to your own view settings will not impact other users.  
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Adjusting Folder Content Displayed in Main Inbox Folder 

To change what Inbox Folder content (Inbox content only or Inbox + subfolder content) you see in the 

Main Inbox:  

1. Click the More View Options Dropdown button 

 

2. Select Modify View. 

3. The Modify Inbox Documents View window will open.  

4. Change Show Documents In: selection to “Selected folder and subfolders.” 

 

5. Click OK to preserve your changes. 

6.  

NOTE: Primafact’s Default “Show Documents” setting is to show documents in Selected Folder Only.  

You may make additional changes to your Inbox view using this window as described elsewhere in this 

Guide. 
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Updating your Inbox View 
You can change your field display in your Inbox  

To do this: 

1. Click the View button and select Format Row. 

 

 

 

 

2. The Format Row Appearance window will open: 

 

 

3. Select Profile Fields by clicking the Select Profile Fields button.  Use the arrows to add or remove 

fields from your display.   
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4. Click OK to preserve your changes. 

5. To position your fields, use the up and down buttons (if you do not see both, they will appear as 

you select an item further down the list. 

6.  Formatting for the selected field appears at the right. 

 

Formatting List Fields 

1. You can change text attributes (color and size) for the selected field on the right hand side of the 

Format Row Appearance window. 

2. To conserve space on lists, text fields, such as Notes, offer the option of showing an information 

icon instead of text: 

 

3. Select your chosen icon using the dropdown. 

 

4. Click OK. 

5. Add any filters, if desired. 

 

  



 

Working with Primafact 6  - New Feature User Guide  25 

Saving your View for Future Use 
To save your view for use as a “Saved View”: 

1. Click the View button and select Save View. 

 

 

2. The Save View button will appear. 

 

3. Name  your view.  You can set this view to Personal visibility (meaning only you will see this view), 

or Public visibility, which makes this view available to other users.  

4. Save your view when complete. 

 

See Customizing List Views below for more details on formatting Saved List Views. 

NOTE – Be careful if creating a new view using an existing view as you have the option of overwriting the 

current view with the new settings. 

  



 

Working with Primafact 6  - New Feature User Guide  26 

Document  Review Workflows: Reviewing Documents within your Inbox 

Primafact Inboxes are designed to make it easy to review your documents right within your Inbox.  In 

addition to search and filter features, the Primafact Inbox has a number of review supports, including 

“For Review” marking, a dedicated Notes field and a team Discussion tool. 

 

Early Case Assignment - Assigning Documents to a Case before Filing 
The Early Case Assignment tool lets you assign documents to a Case before filing.  This allows you to use 

Case coding tools while a document is awaiting review within Inbox, allowing users to effectively 

complete document reviews and coding as soon as a document is received.  

To assign your document to a Case: 

1. Select the Document(s) in the Inbox. 

2. Select any of the first four tabs in the preview Window. 

 

 

3. Start typing part of the Case Name in the Case area to display matching options. 

 

 

4. Select the desired Case. 

 

5. Click the Assign button to assign to the Case. 
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6. Once assigned, the Case field will turn Grey.  

 

 

7. Clicking the dropdown button beside the binder icon will display all locations where the 

document can be accessed in Primafact.   Clicking any of the listed locations will take you to that 

binder or folder in Primafact.  (This is a single document; all locations contain copies of that 

document.) 

 

 

8. Now you can apply any Case coding to your document. 

NOTE – When the document is filed in a Case Binder in Primafact, the document copy will be removed 

from the Unfiled folder in that Case. 
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Marking a Document “For Review” 
You can mark your own documents “for Review” or mark for review by another User when sending 

them a document.  

Review Indicator 

Documents marked for review will have the reviewers’ initials displayed on the first four Preview Tabs 

when viewing the document Preview. Reviewers’ initials appear on the Profile Tab when viewing the 

Open document in the Normal View. 

 

 

• Initials in Brown (JZ in this image) indicate a document is marked “For Review” for that user, but 

not marked done.  

• Initials in Green (KJ in the above image) indicate a document has been marked as reviewed by 

that user. 

 

Marking a Document for Your Own Review  
To indicate that a document requires your own review, click the dropdown arrow beside the Inbox Icon 

on the Preview Tab (Profile Tab on an Open Document). 

Click Mark for Review. 
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Marking a Document for another User’s Review 
When sending a document to another User, select the “For Review” button on the Send Document(s) 

window.  The document will be marked for that user’s review when sent.  To mark a document for 

multiple users’ review at a time – see Sending Documents to Other Users’ Inboxes. 

 

Marking a Review Done 

To mark your review Done, click the checkmark button to the right of the Inbox icon.  Your brown 

initials will turn green, and the document will no longer be marked “For Review.” 

 

NOTE – Clicking the checkmark button will mark the item as “done” by you, and add your initials in 

green, even if you did not mark the document “for review” before clicking the checkbox. 

Changing a “Done” review back to “For Review”  

To return your reviewed document to “For Review” status, click the checkmark button to the right 

of the Inbox icon.  Your initials will be changed to Brown, and your document will be returned to the 

“For Review” list. 

 

Unmarking a Document For Review 
To unmark a document for your review, click the click the dropdown arrow beside the Inbox Icon on the 

Preview Tab (Profile Tab on an Open Document). 

Click the Unmark for Review option.  Your initials will be cleared.  (You will need to do this twice if your 

initials are displayed in green.) 
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Inbox Filter: For Review 
You can quickly filter to your Inbox items marked “For Review” by you (and not marked done) by clicking 

the “For Review” Button on the blue Tab Bar located at the at the bottom of the Inbox. 

 

 

See  Marking a Document “For Review” for more details on this feature. 

 

 

Sending Documents to Other Users’ Inboxes  
You can easily move documents to other Users’ Inboxes, or send copies to other users for filing or 

review while the document remains in your Inbox, allowing concurrent review for multiple users.  

To Send Documents to a Single User 

To send to a single user, you can drag and drop the selected document(s) from your Inbox into the other 

user’s Inbox.  A dialog will appear, giving you the option of moving or copying the document.  You can 

add a message, Mark “Urgent,” and/or “For Review.” 
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To send to multiple recipients at the same time: 

1. Select your document(s) 

2. Right-click after selecting your document(s) and select Send to Inbox. 

 

 

3. The Send Document(s) to Inbox(es) window will appear. 
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4. Type the recipient initials in the top field (as you type matches will appear. Click on the item on 

the menu or Enter to select.  

 

 

5. You may add a message if you wish.  (Messages appear on the document Discussions tab) 

6. You may also mark documents Urgent or For Review. 

7. NOTE – Documents sent using the Send to Inbox menu item stay in your Inbox after sending. If you 

wish to delete from your Inbox you will need to delete after sending to other users.  They remain 

selected after sending so are easy to identify. 

 

Sending A Message (Document Discussions) 
You can add messages to documents as you send them to other users. These are called Document 

Discussions and appear on the Discussions tab on a document. 

Messages can be added as you send a document in the Messages area of the Send Document(s) 

window, or sent from the Discussions Tab of the selected document. 
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Directing recipient to a specific page 
You can direct your recipient to a specific page of your document by right-clicking on the page in the 

Preview area, right-clicking and selecting “Send to Inbox” from that page.  The document will open on 

that page in the recipient’s Inbox.  

Document Discussions Tab 

All messages on a document appear on the Document Discussions Tab. You can send a message to 

another user by entering their initials in the To area near the bottom of the Tab. 

 

Replying to a Selected Message 

You can reply to a specific message by clicking on that message, and your message will be directed to 

that user.  

You can direct recipients to a specific page by entering the destination page in the Page area before 

hitting Send. 

 

Adding Persistent Notes and Instructions 
You can add a more persistent notes and instructions by entering them in the Notes area on the profile 

field, or other field that your team has designated for Instructions. 

You can set this field to appear on your Inbox view, either as a text field, or as an [i] icon, which, when 

displayed, indicates content has been added to that field. 

See Updating Your Inbox View for details on how to make Notes visible on your Inbox List.  
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Popping out your Inbox 

screen into a new 

window makes filing 

easier, since you can 

view both locations 

side-by-side. 

Pop-Out Inbox 
You can Pop Out your Inbox screen to view it alongside other Primafact windows.  This is designed to 

make activities like filing easier.  You can pop-out any Inbox folder, and other list views as well.   

To Pop Out your Inbox, select the Pop-Out button  on at the far right of the main toolbar: 
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Viewing Other Users’ Inboxes 
You can view documents in other users’ Inboxes and Inbox folders.  We do not recommend that you 

complete your own document reviews while viewing another viewer’s Inbox. 

Selecting Visible Inboxes 
You can select which users’ Inboxes are visible to you in Primafact.  

To choose which User Inboxes are visible: 

1. click on the Select Visible User Inboxes button on the Inbox Toolbar: 

 

 

2. The Select Inboxes window will open. 

 

 

3. Check the User Inboxes you want to have visible in the Folder view.  (Your own Inbox will not be 

visible on this list, as it is viewable by default.) 

 

4. Click OK to save your selection. 
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Viewing another User’s Inbox (“View As”) 
To view another User’s Inbox, you will be viewing content from the perspective of that user.  You can tell 

you are in another user’s inbox, because the Blue Tab Bar will change to a shade of purple and the other 

user’s initials will appear on the left-side of the Tab Bar. 

 

Note – You do not have an Unread option available when “Viewing As” another user.  

 

 

Working with Annotations 

Updated Coding Tools  
Primafact’s Annotation Forms have been updated to support more uniform visual coding, along with 

fields to enable quick assembly of Chronologies, Discovery Outlines and other reports. 

Annotation Forms offer automation options for more efficient coding. 

 

Annotation Form Updates 

Simple and Expanded Form 

The annotation form can now be expanded to hold more information.  Clicking the Show More / Show 

Less button at the bottom-right corner of the Annotation form will expand or limit the display.  

Simple Form:      Expanded Form 
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Additional Fields on Expanded Form: 

In addition to fields on the Simple Form, Fields on the expanded form include: 

• Text Excerpt 
(New) 

Dedicated area for quoted document content, distinct from the 
Annotation Note field.  Allows verbatim content to be included separately 
in Reports 
 

• Annotation Author Creator of the Annotation 
 

• Annotation Date Date Annotation was added to Primafact by Annotation Author 
 

• Annotation Type Optional Field – Defaults to Analysis.  Dropd-down options include Fact, 
Handwriting, Highlight, and Question 
 

• Report Author Originator of document content 
 

• Page Image Annotated Page in Primafact – provides annotation convenient context. 

 

 

Event Date & Time 

The Event Date field is a new field displayed at the top-right area of the Annotation Form.  It is designed 

to support event chronologies.  This dedicated field is designed to preserve the date (and optionally, 

time) of the annotated content as it would appear in a chronological record of Case events.  

Why use this field? Completing the Event Date (and optionally, the time) on an annotation form enables 

swift assembly of Case Chronologies. 
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Labelled Color Coding  
Primafact now includes up to 18 colors, which can be labelled by the firm for more uniform coding and 

more visual identification when viewing documents and binders. 

Why use this field?  Color-coding annotations with standardized colors & labels makes it easier to 

recognize the broader category of an annotation for more efficient Case preparation.  Annotation 

Coding tools help to break down annotation content into manageable and relevant groupings for 

downstream Case preparation and analysis. 

 

 

Issue Coding 
While Issue Coding has been available in Primafact 5, you can now add Annotation Issues to Case 

Templates to more efficiently leverage document standards across Caseloads. 

Why use this field?  Issue coding allows more subtle categorization of Case Issues for refined analysis 

and reporting. 
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Favorability Coding 
Dedicated favorability buttons (thumbs-up  and thumbs-down ) make coding for adversarial value 

efficient and highly-recognizable.  You can filter annotations by adversarial value to quickly assemble 

materials marked as notably helpful or adverse to your case. 

Why use this field?  Thumbs-up and thumbs-down buttons are instantly recognizable when viewing 

documents and binders – document views display the thumbs-up and thumbs-down codes right on the 

document, for instant identification when reviewing materials.  You can filter annotations by adversarial 

value to quickly assemble materials marked as notably helpful or adverse to your case, making 

preparation for negotiations particularly efficient.  

 

 

Text Excerpt 
The Text Excerpt Field, found on the Expanded Annotation Form, is a dedicated location to house the 

verbatim excerpt subject of the annotation. You can auto-populate any OCR’d text in this field by 

clicking the T button below the bottom right-corner of the Text Excerpt field.   

Why use this field?  Designed for building reports, the Text Excerpt field provides a distinct area to house 

text citations, distinct from reviewer comments in the Annotation Notes field.  
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Working with Annotations – Advanced Efficiencies  

New automation tools, including Annotation Templates and Annotation Repeat tools are designed to 

make repetitive coding more efficient.  

Annotation Copy 

Copy Annotation Content to another Annotation 
Use the Annotation Copy button to copy instantly copy Annotation content into another Primafact 

Annotation. 

1. Open the annotation you wish to copy. 

 

2. Click the Copy button. 

 

 

3. Click OK to close annotation. 

 

4. Create new annotation in desired location. 
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5. Click Paste Annotation button. 

 

 

6. All copyable fields will populate the current annotation. 

 

7. Click OK to save and close. 
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Annotation Repeat 
The Annotation Repeat tool makes repeat annotations, such as identifying references to a specific issue, 

quicker and more efficient.  You can repeat with or without the annotation dialog.  (Repeating with the 

annotation dialog works well when you want to repeat specific fields and add additional annotation-

specific coding.  Repeating without the annotation dialog works well when you want to repeat coding 

and quickly move on.) 

 

Using Annotation Repeat 
1. Open an annotation form (this can be a new or existing annotation). 

2. Populate the fields you wish to repeat. 

3. Optional – Select Fields to Repeat   

a. Click the Start Repeating dropdown button > Select Fields to Repeat button to select 

which fields you will repeat from the available options. 

 

 

 

b. Check the desired items from the Annotation Auto-Repeat Options checklist.  Click OK.  

(Primafact will use the last selection if you do not select fields to repeat.  Primafact will 

use the default selection if you have never selected fields to repeat.) 

 

4. Repeat with or without Annotation Dialog: 

a. Repeat with Open Annotation Dialog:  

i. Click Start Repeating  

ii. Create a new annotation.  Annotation Form will open with selected fields 

populated.  Update as desired.  Click OK to save and close. 

iii. Annotations will continue to open with selected fields repeated until Repeat is 

stopped. 
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b. Repeat without opening Annotation Dialog 

i. Click Start Repeating dropdown  

ii. Click Start Repeating without Annotation Dialog 

 

iii. Create a new annotation.  Annotation will be created with selected fields 

populated without form opening  

iv. Annotations will continue to be created with selected fields repeated until 

Repeat is stopped. 

v.  

Stopping Annotation Repeat 
When you are ready to stop repeating your Annotation, click the green Stop Repeating button at the 

top-right of your Primafact window. 

   

 

 

Create Chronologies and Reports  

Comprehensively and consistently annotating your Case documents means more effective future 

preparation. Applying structured annotation coding makes it possible to pull together detailed reports in 

moments, for efficient preparation and review as your case progresses.  

Reports are assembled using the Annotation List View, and can be easily exported to Word, Export, Excel 

and PDF.  

You can create highly customized reports in a table format, based on your requirements.  Report 

examples include: 
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• Detailed Chronologies 

• Issue Chronologies 

• Discovery / Witness Preparation Charts  

 

The Annotation List View 
Reports are assembled using the Annotation List View, which can be accessed by selecting the 

Annotations option on your Blue Case ribbon.  You must select a Case Binder to view the blue Case 

Ribbon.  

 

 

Note: You can create custom Annotation List views to precisely set the columns and sort order of 

chronology reports exported to Word.  See Customizing List Views below. 

 

Assembling your Report 
To display the specific content required for your Report you will typically filter and sort the Annotations 

appearing on your List. 

To change the displayed annotations from the content displayed by default, you can filter and sort.  You 

can also use saved Views to quickly apply pre-set Annotation List formatting and filters.  See Customizing 

List Views, below for details on customizing your List View to display a custom report formatting and 

filters. 

When you have your Annotation List filtered and sorted into the desired content and presentation, you 

are ready to export your report.   

 

  
Create customized 

Annotation List views for 

quick and precise control 

over the appearance and 

order of exported reports 

and chronologies. 
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Export to Word  
To export your displayed Annotation List to a Word table 

1. Click the Report Dropdown and select Copy to Clipboard (for Word) 

 

 

2. Paste into your Word document. 

 

Create a Chronology 
Assembling an Event chronology requires the Event field to be completed on your Annotation forms.  

Event chronologies use the date in this field to sort by date. 

 

If your list is sorting by another column, you can sort your Event Date column to present your 

annotations in chronological order.   

Simply click on the Event Date column to sort your displayed annotations in ascending or descending 

date order. 
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If your displayed view does not include an Event Date column, switch to a view that includes the Event 

Date by clicking on your View Selection Dropdown.  

 

 

To add an Event Date column to your Annotation List, you can adjust your List Formatting to include 

different field selections and ordering.  See Customizing List Views, below.  

To export your chronology to Word use the Report Dropdown, as detailed in Export to Word, above. 

 

Filtering by Date of Loss 
Primafact includes a built-in DOL filter that allows you to filter to events occurring pre-DOL, or on and 

after the DOL.  To use this tool, the DOL must have been entered into the Case Summary.  

To filter a List by Date of Loss: 

1. Select the Event Date filter on your Annotation List 

 

 

2. The Annotation Event Date Filter dialog will appear. 
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3. Click the appropriate checkbox to filter to dates before or after the Date of Loss, as applicable: 

 

 

4. Click OK to apply filter.and close dialog. 
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Annotation Batch Updates 

You can now update multiple annotations on a single Case in the same operation using the Annotation 

List.  This is a good way to update large numbers of annotations if you are using new coding values.   

You can use this option to  

✓ replace or amend certain values (e.g. turn light green annotations to mid-blue) 

✓ update other fields (e.g. find green annotations and add favorability coding) 

You can update: 

✓ all annotations 

✓ all filtered annotations 

✓ selected annotations (selected using CTRL+ select or SHIFT+ select) 

 

 

Be careful when Batch Updating – there is no utility to automatically revert back to prior coding if you 

make a mistake.  Firms may wish to limit personnel permitted to perform batch updates. 

 

To perform a batch update: 

1. Filter your Annotations to the items you wish to update (in this example we’ve filtered to all of 

our Case annotations coded green): 

 
 

2. Optional: Select specific annotions from this list (if desired). 

  

! 
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3. Click the Gear icon on the bottom-right corner of the Annotation screen: 

 

 
  

 

4. Select Annotations > Annotation Batch Update 

 
 

5. The Annotations Batch Update will appear. 

 



 

Working with Primafact 6  - New Feature User Guide  50 

6. Choose which annotations you wish to update: 

a. “All annotations in current list” means all annotations in your current view, which may 

be filtered 

b. “Selected annotations” means annotations you have manually selected using 

CTRL+select or SHIFT+select  

7. Choose the field you wish to update using the dropdown:  

 

 

 

 

 

8. Next select the updated value (options will vary by field selected) 

 

Remember - in this example, we want to take all of the annotations coded “green” and make them 

“favorable.”  We have filtered to “green” and are now updating the favorability field to “favorable.” 

 

9. Repeat step 7 on the next value if desired.  (e.g. I may wish to take all the green annotations 

converted to favorable and change the color to something else, like yellow or blue). 
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Customizing List Views 

Creating multiple List Views in Primafact makes it easy to switch list displays at the touch of a button for 

more relevant case viewing and report assembly.  Customizing views makes it quick and easy to suit 

your precise needs when viewing Case materials in Primafact. 

Views can include specific fields and formatting, as well as pre-set filters for quick and consistent list 

presentation. 

One major benefit of customizing Annotation List views is that it enables you to precisely select the data 

fields and sort order appearing in your exported reports and chronologies. 

This section shows how to work with Annotation List Views, but these instructions also apply to setting 

views for other lists including your Inbox and the Document List View. 

 

The Home View (Default List View) 
The Home View is the default view that you view when you first open a List view. You can change your 

home view if you prefer to see a different default display.  You can quickly reset your display to the 

home view by clicking the home view button at the top of your list toolbar. 

 

To change your Home View see Change Your Default Home View, below. 

  

One benefit of customizing 

Annotation List views is 

precise control over the 

appearance and order of 

exported reports and 

chronologies. 
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Creating a New View 
You can create custom views to display your lists with your preferred fields, formatting, filters and sort 

tools. 

1. To avoid overwriting an existing view, start by saving your new view.  Click the View Dropdown on 

your list toolbar: 

 

 

2. Click Save View. 
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3. Name your view and add a description for future guidance.   

Visibility: Click Personal if 

you are creating the view 

for yourself or Public if 

you wish to create a view 

for other users.   

Apply to: Click All Cases 

to use this view in other 

Cases.  Apply to This 

Case will make this view 

available to this Case 

only.  (Case views can be 

copied to other Cases 

using the Updating 

Existing Cases Using Case 

Templates feature) 

You can complete this step once you have finished creating your View, but doing this step first 

helps to preserve existing Views without unintentionally changing existing settings. 

Formatting your View:   
1. To format your current view, click the View dropdown on your List toolbar and select Format 

View. 
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2. The Format Row Appearance dialog will open. 

 

This is where you can specify which fields appear on your list, the order of your list columns, and 

row formatting (size, color etc.)  

 

3. Selecting Columns appearing on your list: To select which columns appear on your List click the 

Select Profile Fields button on the Format Row Appearance dialog.  
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4. The Select List Columns dialog will open. 

5. Click items from the columns and use the blue arrows to add or remove fields from your List.   

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Note: You can include fields from other areas of Primafact (such 

as System fields including Team Flags and document Reviewer 

Information, or other Profile Categories by using the Profile 

Group Dropdown to change your Profile Field selection options: 

 

 

 

6. Once you have selected your fields, click OK. 

Note: Reports and Chronologies export to Word in Table format. If you are creating a view for 

export to Word, keep in mind the number of columns that will comfortably fit on your page. 

TIP: If you are 

creating a view for 

export to Word, keep 

in mind the number 

of columns that will 

comfortably fit on 

your page when 

adding columns to 

your view 
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7. Next, on the Format Row Appearance dialog, use the blue up and down arrows to position your 

fields in the desired position on your list – items from top to bottom are displayed from left to 

right on your list.  
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8. To Change Column Formatting, such as changing text color or size, click on the field name and 

make your column formatting selections on the right hand side.  In this example, I am making the 

author column text bold and pink for quick visual identification: 

 

 

Save your View.
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9. If you are Saving updates to an existing list, select the Overwrite View option.   

If you are saving a New view, name and save as a New View, completing the Visibility and Apply to 

fields.  

 

 

Additional View Formatting – Sort Order, Groupings and Filters 
To specify your list’s sort order (essential for chronologies), as well as applying groupings and additional 

filters, you will need to use the Modify Annotations View dialog.   

1. Click the View dropdown and select Modify View. 
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2. The Modify Annotations View dialog will open. 

 

3. Adjust your settings as desired.  Click the Descending checkbox to sort in descending order (e.g. 

Z-A, or most recent items on top. 

4. Click OK to apply and Save your settings to your Saved View. 

 

NOTE: You can also select Profile Fields, format Row Appearance and visibility using the Modify 

Annotations View dialog, so if you are creating  a very detailed List View, it can be helpful to start with 

this screen after creating your view.  
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Change your Default Home View 
You can select any of your Saved Views to appear as your Home View on your List Screen, to make it 

convenient to access your most frequently-used view settings. 

1. Click the View Dropdown on your list toolbar: 

 

 

2. Select Manage Views. 
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3. The Manage Views dialog will open. 

 

 

4. Click the Make Home View button.  Click Yes to proceed and set your new Home View. 

Note: If your selected view is an All Cases view, this will reset your Home View for this List Type 

across all Primafact Cases.  (This will not impact your Inbox Home View Settings. 

If your selected view is a Case view, this will reset your Home View for this Case only.  (If this 

setting is applied to a Template, the home view will be applied to Cases based on the Template, 

unless reset by the User.) 

Resetting your own Home View settings will not impact other Users.  

 

5. Clicking the Home button will open your new Home View.  
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Creating Electronic Briefs 

Primafact 6 includes several new features designed to more conveniently assemble materials for sharing 

outside the firm right within Primafact.  New features include  

✓ Highlighting - Looks like a standard highlight, to direct attention to specific content and 
  designed for export 

 
 
 

✓ Linking - Allows linking to content outside Primafact (e.g. external websites, such  
  as CanLii Case reports  
 

- Allows linking to Primafact Content (in the same exported document or  
  Tabbed PDF) 
 

✓ Title Aliases Add up to 5 alternate Document Titles to efficiently meet document 
naming requirements for court submissions – this preserves preferred 
document names without needing to duplicate new documents for other 
purposes 
 

✓ Binder Bundles - New Binder type designed for export; includes title alias selection for  
  exported document and document sets 

 

 

Adding Highlights 
You can add highlights to your documents in Primafact 6 to call attention to key content.  Highlights are 

designed to be shared outside the firm, and you can elect to include or exclude highlights when 

exporting your documents as PDFs.  

Using the highlighting tool to add a highlight: 

1. Open your document.  

2. Select the Highlight tool from the markup options on your toolbar. 
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3. If desired, use the Highlighter dropdown to select a different highlight color. 

4. The highlighter tool will appear. 

5. Draw one or more boxes around the text you wish to highlight. (Highlight boxes can be selected 

and resized.) 

6. Click to set highlight.  

Highlights appear as transparent linear overlay over document content: 

  

 

 

7. When you have completed highlighting reset markup tool to pointer or annotation setting: 
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Adding Links 
You can add links to your Primafact documents to other Primafact document locations and to online 

resources outside Primafact.  Links can be included in PDF exports from Primafact. 

 

Using the linking tool to add a link to a Primafact location: 
1. Open your document.  

2. Select the Linking tool (the document markup setting defaults to “create annotation”). 

  

3. The link tool will appear. 

 

4. Depress your left mouse-click button to draw a box around the area where you want to insert 

your link.  

 

5. The Create Link dialog will open.  
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6. You have the option of Creating a PRIMAFACT link or a WEB link.  If linking to a Primafact 

document, click the Create a PRIMAFACT link checkbox. Adjust the color if desired. 

 

7. Click Next. 

8. Add a link note if desired.  

9. Navigate to the desired location in Primafact where your link will lead. 

10. Click Set Link. 
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11. Link will be set to the specified Primafact location.  
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Using the linking tool to add a web link (location outside Primafact): 
1. Open your document.  

 

2. Select the Linking tool (the document markup setting defaults to “create annotation”). 

  

3. The link tool will appear. 

 

4. Depress your left mouse-click button to draw a box around the area where you want to insert 

your link.  

 

5. The Create Link dialog will open.  

 

6. You have the option of Creating a PRIMAFACT link or a WEB link.  If linking to a Primafact 

document, click the Create a WEB link checkbox. Adjust the color if desired. 
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7. Click Next. 

 

8. Add a link note if desired.  

 

9. Specify the web link URL address.   (Primafact will support Chrome’s link to highlight feature, to 

direct link to a specific web page location, such as specific CanLii paragraph citation.) 

 

10. Click OK. 

 

11. Link will lead to specified external link location. 

 

Opening Links inside Primafact 

Opening links on an open document  
1. Right-click over Link location and click Open Link. 

 

Opening links in the document Preview  
1. Left-click on Link and select Open Link.  
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Adjusting Markup Display on a Document in Primafact 
You can set visibility of document markups on an open document in Primafact – this can be helpful if a 

heavily marked-up document is distracting.  

To adjust markup display settings: 

1. Click the Show dropdown on the open document toolbar: 

 

 

2. Click the markup items you wish to hide or display. 

 

Bundle Binders 
The Bundle Binder is a new type of Binder designed for sharing documents with entities outside your 

firm, and particularly to support efficient creation and export of court submissions, including CaseLines 

submissions. 

Bundle Binders include a number of features designed to facilitate e-brief production, including: 

✓ Multiple Title Aliases, allowing you to assign more than one title to the same document, so the 

document can be renamed instantly depending on where the document will be submitted (e.g. 

Firm Document Standards and CaseLines titles can be applied to the same document) 

✓ Copy binder to Tabbed PDF – This feature is available in Primafact 5, but designed for more 

streamlined application. 
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Create a Bundle Binder 
1. Right-click your Case Binder 

2. Select New > Bundle Binder 

  

3. Name your binder, and add Tabs, Sections and Documents as applicable. 

Using Document Alias Titles 
*** 

Export a Bundle Binder as a PDF 
Primafact 6 has updated the PDF export tool to support easy exchange of organized, multi-document 

tabbed briefs.   

An exported bundle binder allows you to efficiently export a structured 

document set in a single tabbed PDF, including: 

• Bookmarks to each document 

• Binder Page Numbering 

• Alternate document Titles  

• Highlights (if desired) 

• Primafact links to other documents in the bundle 

• Web links  

• Bates IDs where applicable 

• Annotations (if desired) 

Large files can be easily uploaded to CaseLines, online portals, document exchange tools and other 

locations outside Primafact. 

 

 

 

  

PDF bundle binders preserve links  

to other document locations  

in your bundle 
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To export your bundle binder as a PDF: 

1. Click the Binder-to-PDF button at the top of the Bundle Binder 

    

2. The Saving from Primafact window will appear 

 

File name defaults to 

name of Binder.  

Rename if desired. 

 

Change destination 

folder if desired by 

clicking browse button 
 

Single PDF file 

selection will create a 

single tabbed PDF with 

documents ordered as 

they appear in your 

Bundle Binder  

 

Document titles 

default to Title set 

selected in Binder, but 

you can use dropdown 

to select a different 

set of alias titles. 

 

Other options may be 

included as desired 

 

Click Open in Explorer 

checkbox to 

immediately access 

your saved PDF. 
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3. Select the desired output and click OK when complete.  

Note:  To upload individual documents, see Upload to Portals, below. 

 

Upload to Portals  

Document Export (Copy to Browser) 
You can now upload documents to browsers directly from Binders and Inbox folders1.  This eliminates 

the “extra step” of dragging documents from Primafact to a local folder before exporting to locations in 

the Cloud. 

Copy Documents to Browsers and other locations outside of Primafact 
To copy documents directly to browsers or other locations outside Primafact, including Windows 

Explorer location: 

4. Select your documents 

5. Click the Export Button  

6. A separate window will appear.  Drag the Green box to your target window. 

 

7. Confirm your upload. 

8. Close the Upload from Primafact window. 

If you are sending very large documents, it may take a moment for your documents to be ready.  You can 

continue working in Primafact as the documents are prepared for sharing. 

 

 

 

1 Requires a supported browser. 
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Primafact 6 Team Customizations 

Primafact 6 enables more customizable settings for coding, including annotation colors and labels, 

annotation default form settings, and team flag colors and labels. 

Customizing Annotation Color Labels 
Customizing Annotation Color Labels makes it easier to standardize annotation color coding. 

Customizing System Default Annotation Labels 
1. In the main Primafact Toolbar, select Tools > Setup > Annotation Colors. 

 
 

2. The Annotation Color Labels window will open. 

 
 

You will see 12 colours.  Click Show Additional Colors to make 6 additional colours available. 

Select the colors you wish to use by clicking the checkbox to the right of the selected color.  

Enter the color label in the text area of the selected color.  

Click OK. 

Now you have set your Annotation Color system defaults. 



 

Working with Primafact 6  - New Feature User Guide  75 

Customizing Case Default Annotation Labels 
If you want to customize your Annotation Color Labels for a specific Case: 

1. Open any Case Binder. 

2. Click the gear icon at the bottom-right the Primafact Window: 

 

3. Select Annotation Labels. 

 

4. The Case Annotation Labels screen will open.  

  

5. Select Override default. 

 

6. Add or rename any color that you wish to customize for the Case.  (Colors that you do not 

rename will retain the default system labels.) 

 

7. Click OK. 

Note you can copy values from another Case by clicking Copy from Another Case button, selecting 

the desired Case and clicking OK, then Yes to confirm. After the Case values have been copied, you 

can continue to customize your current Case labels as desired. 
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Annotation Form Customization (Event Time) 
To add or remove the Event Time field from the Annotations forms on a Case, click the Gear icon at the 

far right of the blue Case Ribbon and select Annotation Colors.  Select the Annotation Fields tab. Select 

or de-select the “Event Time” checkbox and click “OK.” 

 

 

 

Customizing Team Flags 
Team flags are colored document-level flags.  Adding labels helps ensure their use is standardized across 

the team. 

Customizing System Default Team Flag Labels 
1. In the main Primafact Toolbar, select Tools > Setup > Team Flag Labels. 

 

 

2. The Default Team Flag Labels  window will open.  
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3. Enter the desired label in the field to the right of your flag.  

 

4. Click OK to save. 

 

 

Customizing Case Default Team Flag Labels 
 

To customize your Team Flag Labels for a specific Case: 

1. Open any Case Binder. 

 

2. Click the gear icon at the bottom-right the Primafact Window: 

 

3. Select Team Flag Labels 
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4. The Case Team Flags  window will open. 

 

5. Select Override default. 

6. Enter the desired label in the field to the right of your flag.  This will overwrite the system 

default. 

7. Select OK to save.  

Note: To copy values from another Case, click the Copy from Another Case  button, selecting the 

desired Case and clicking OK, then Yes to confirm. After the Case values have been copied, you can 

continue to customize your current Case labels as desired. 
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System-Wide Annotation Form Default Settings 
You can now customize default annotation values.  An example would be opening Annotations to a 

different colour than yellow.  Setting annotation defaults can be done at the system level (globally, for 

all users), and at the Case level (for all users while using that that Case). 

 

Adjusting Annotation Defaults – Global Settings: 
1. To change your firm’s global setting, go to 

Tools > Setup > Annotation Templates 

 

 

 

 

2. The Manage Case Annotation Templates dialog will open. 

 

 

3. Select Default Annotation Values. 
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Adjusting Annotation Defaults – Case Settings: 
You can set default values for individual Cases, overriding global annotation defaults and annotation 

templates for that Case.  

To change default annotation settings for a Case: 

4. Click on the gear icon at the right-corner of the Case ribbon: 

 

 

5. Click Annotations > Annotation Templates on the drop-down menu: 

 
 

6. If you have not activated Case-level templates, the template override warning will appear.  If you 

click “Yes” the Case Templates will disconnect from the Global templates2.  

 

  

 

2 You can reset back to Global templates but will lose any Case template customizations.  (Any existing annotations 
made using the Case template settings will be preserved.) 
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7. The Manage Case Annotation Templates dialog will appear.  Select Default Annotation Values and 

click the Modify button. 

 
 

8. The Annotation Template Definition will open.  

 
 

 

9. Set your field preferences and click OK.  This works similarly to the settings for the global default 

annotation values, except you have the added option of adding Issues to the default Case 

annotation settings. 

 

 

10. Your default annotations will open at the set values for this specific Case. 
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11. Click Modify. 

 
 

12. The Annotation Template Definition will open.  

 
 

 

13. Set your field preferences and click OK. 

 

 

14. Your default annotations will open at the set values, unless you have set a different annotation 

for specific Cases. 
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Technical Support 

 

Thank you for participating in the Primafact 6 Beta.  We appreciate your time and feedback!  

If you experience any bugs in the program please contact Primafact Support at support@primafact.com 

or 416-531-1891.  The support desk is available from 9am-5pm ET Monday-Friday. 

mailto:support@primafact.com

